
  

 Midwestern State University 
Robert D. & Carol Gunn College of Health Sciences & Human 

Services 

Course Number:        4123  NURS/RADS/RESP/SOWK                        
3 credits                     Spring 2022 

Course Title:              Data Analysis 

 
Professor 

Mandy Sedden MSRS, RT(R)  
Email:  mandy.sedden@msutexas.edu 
Use this information in the subject line: 4123_your last name_topic of the message.  
Email is the best way to reach me. If I have not responded within 72 hours, please email 
me again.  
Phone: (940) 397-4664  
Office Location: Midwestern State University  
                            3410 Taft Blvd.  
                           Centennial Hall 430M  
                            Wichita Falls, TX 76308  
Office Hours: Please make an appointment 

 
Course Communication  
Contact information for the instructor is listed at the beginning of this syllabus. Email is 
the instructor’s preferred mode of communication. The instructor will respond or at least 
acknowledge email messages from students within a maximum of five (5) business 
days when MSU is in session. Beyond standard university holidays and breaks, the 
instructor will notify students of any extended periods of time when email contact is not 
practical (professional meetings, etc). 
Please use the following format in the subject header for your email: 
4123x22_your last name_topic of message 
Example: 4123x22_Smith_Quiz 4 

  
When emailing the instructor, please include your full name, course and section 
number, and a thorough explanation in your message. This will help expedite your 
request or needs. 
  
When there is a need to contact students, the instructor will use the student’s MWSU 
email account, students.mwsu.edu. The instructor is not responsible for sending emails 
to any other email account.  Faculty members will not be responsible for keeping up 
with other email addresses for students. If you have not established this account, do so 
as soon as possible by going to: http://infosys.mwsu.edu/email.asp  

http://infosys.mwsu.edu/email.asp


   
The instructor will respond or at least acknowledge email messages from students 
within a maximum of five (5) business days when MSU is in session.  MSU is open only 
4 days a week in the summer, so be mindful that if you email the instructor on a Friday 
you might not get a response until Monday. Beyond standard university holidays and 
breaks, the instructor will notify students of any extended periods of time when email 
contact is not practical (professional  
meetings, etc.).  I will meet face-to-face with any interested students by appointment 
only.  This meeting is optional and must be confirmed by email ahead of time with me.  
Feedback  
Feedback varies throughout the course. The News section of the course is where I will 
send  
messages to the entire class. It is best to set up your D2L account to receive an email 
notification  
(to the email of your choice) when News items are posted.  
      1. Click the down arrow in the News section on the 4123 course home page  
      2. Select Notifications  
      3. Check the box next to "News- new item available" and then check any other 
boxes you  
           wish to receive an email notification from.   
      4. Check the email address you wish to send email notifications.  If you need to 
change this,  
          select "change your email settings" and enter the new email address. This email 
address  
          should be an email address you frequently check.  
If you are having technical difficulties accessing the course or any other technical issues 
please contact distance.learning@msutexas.edu .  

 
Course Overview 
The focus of this course is to provide an interdisciplinary data analysis class specifically 
for health sciences and human services majors using techniques and data structures 
relevant to clinical investigations. General topics include choosing correct procedures 
and using statistics to understand clinical data. Specific topics include but are not limited 
to basic statistics, measures of correlation and difference, hypothesis testing and bias, 
confidence intervals, reliability and validity, significance, power analysis, levels of 
evidence, sample size and distribution, assessing effects of treatment, quality 
improvement, relative risk and relative risk reduction, and odds ratio. 
  
This is a three-credit course designed to teach the selection, application, and evaluation 
of statistical analysis techniques online.  There will be the same amount of material 
covered in this course as a traditional classroom-based course and you will need to 
devote a substantial amount of time outside of the classroom mastering the material. 
Your responsibility for the online content includes but is not limited to, viewing chapter 
lectures and homework reviews, completing computer tutorial lessons, reading 
corresponding text material, participating in discussion forums, testing, and submitting 

mailto:distance.learning@msutexas.edu


assignments as directed by the professor and indicated on the class syllabus. You are 
responsible for checking the class D2l page daily.   
  

This is a very intense course that includes a great deal of material that builds on 
the previously presented material.  It is absolutely essential that you keep up with 
the class and do not fall behind.  Make sure you have scheduled adequate time to 
truly master the material each week.  Adding new material without understanding 
the previous work will only compound the problem making it very easy to find 
yourself with severe difficulties halfway through the course.  
  
Weekly content including lectures covering the main topics will be available within each 
unit.  In addition, a review of the homework assignments will be posted in each unit I 
HIGHLY suggest attempting the homework before you view the review of the 
problems.  What seems like a very straightforward topic can be much more 
difficult when you try to apply the concepts.  If you don’t try before you hear the 
answers you won’t know what you have difficulty with before moving forward 
with the material.  This will result in poor outcomes on your quizzes, and 
final.  Trust me on this one! 
  
Course Rationale:  Healthcare providers must be able to critique and understand the 
strengths and weaknesses of research design and analysis in order to be able to 
develop evidence-based practices in a clinical setting.  This course will prepare 
healthcare providers for the selection and application of statistical analysis techniques 
and the evaluation of the results derived from this analysis.  Students will learn various 
entry-level statistical techniques and analyze them within published clinical 
research.  This course is designed for the adult learner and involves extensive 
independent learning and mastery of subject material.  

 
Course Objectives 
Upon completion of this course, the student will: 

• Develop a broad-based understanding of descriptive statistics and selected 
statistical techniques 

• Choose and make the appropriate graph/table for a set of data Describe the 
characteristics of the normal distribution 

• Identify different levels of measurement. 
• Explain Type I and Type II error and the consequences of each error 
• Differentiate independent and dependent samples 
• Explain the effect of alpha, the number of tails, and sample size on the critical 

value of t. 
• Determine the power of an independent-samples t-test and the sample size 

necessary to have an independent-samples t-test with sufficient power. 
• Interpret the results from a chi-square test for contingency tables. 
• Choose an appropriate statistical test to use in analyzing a data set 
• Evaluate diagnostic and screening tests appropriately. 
• Understand the factors that form the basis for hypothesis and statistical testing. 



• Apply statistical outcomes to processes of quality improvement. 
• Use statistical outcomes to evaluate the effects of treatment. 

 
Textbook 

 
Heavey, E. (2019). Statistics for nursing. A practical approach, (3rd ed.). Burlington, 

MA: Jones and Bartlett. ISBN: 9781284142013 

Required Software 
You must use Microsoft Excel software to complete some assignments. Microsoft Excel 
is the spreadsheet software included in Microsoft Office. I will provide instructions for 
using Excel. You will not be able to complete some of the assignments in Excel unless 
you add in the free Analysis Pak. To do this, follow the instructions below from 
Microsoft: (Applies To: Excel 2016, Excel 2013, Excel 2010, Excel 2007, Excel 2016 for 
Mac) 1) In Windows, go to Excel and click the File tab, click Options, and then click the 
Add-Ins category. (If you're using Excel 2007, click the Microsoft Office Button , and 
then click Excel Options. In the Manage box, select Excel Add-ins and then click Go.) If 
you're using Excel for Mac, in the Excel file menu go to Tools > Excel Add-ins. 2) In the 
Add-Ins box, check the Analysis ToolPak check box, and then click OK. • If Analysis 
ToolPak is not listed in the Add-Ins available box, click Browse to locate it. • If you are 
prompted that the Analysis ToolPak is not currently installed on your computer, click 
Yes to install it. 3) The Data Analysis button appears on the Data Tab to the far right. 
This is where the formulas are. 
  

 
Teaching Strategies 

• Online delivery with asynchronous interactions between students and teacher, 
interactive discussions, quizzes, and a comprehensive final examination. 

 
Attendance 
This is an online course, and as such, there are no mandatory sessions. However, the 
students should be vigilant in checking their email and logging onto D2L. Regular 
checks will ensure messages from the instructor and fellow students are received in a 
timely manner. This course is on a schedule that will be strictly adhered to (see table 
below). The instructor will be available to meet face-to-face with any student who is 
interested. Please email the instructor to schedule an appointment. 

 
Requesting a Withdrawal 
Last Day for “W”, March 21 by 4:00 p.m. – Drops after this date will receive grades 
of “F.” Refer to the Undergraduate Bulletin for details about receiving a grade of 



“Incomplete” in a course. In an emergency or extenuating circumstance, a student may 
request a grade of “Incomplete” in a course before grades are submitted. If the 
instructor grants the “Incomplete,” the student has until thirty (30) days after the 
beginning of the next long semester to complete the course requirements.  If the student 
does not complete the course requirements within the deadline, the grade of 
“Incomplete” will automatically convert into a grade of “F.” 

 
Grading/Evaluation 
Evaluation 
            Quizzes                                   30% 
            Discussion Board                    45% 
            Comprehensive Final Exam    25% 

Grading Scale 
            A = 90-100 

            B = 80-89 
            C = 70-79 

            D = 60-69 
            F = 59 and below 

Midterm Grades 
In order to help students keep track of their progress toward course objectives, the 
instructor for this class will provide a Midterm Progress Report through each student’s 
WebWorld account. [only at-risk students will be reported].  Midterm grades will not 
be reported on the students’ transcript; nor will they be calculated in the cumulative 
GPA. They simply give students an idea of where they stand at the midpoint of the 
semester.  Students earning below a C at the midway point should schedule a meeting 
with the professor. 

 
 Technical Difficulties 
On occasion, you may experience problems with accessing D2L, accessing class files 
located within D2L, connecting with your internet service, or you may encounter other 
computer related problems. Make the professor aware of a technical problem as soon 
as possible. If a problem occurs on our end, such as D2L failure, then a due date 
extension will typically be granted. However, keep in mind it is your responsibility to 
have (or have access to) a working  
computer in this class. Assignments and tests are due by the due date, and personal 
computer technical difficulties will not be considered reason for the instructor to allow 
students extra time to submit assignments, tests, or discussion postings. Dropbox 
assignments that can be attached in an email should be emailed to the professor as 
soon as a problem is encountered. Failure to do so may result in points being lost, 
regardless of connection issues.   
For help options:  
          • For D2L issues go online go to the Distance Education Helpdesk  
          • By phone call the Distance Education office at 940-397-4868 between 8am and 
5pm.  
          • Use the D2L help link in D2L.   
          • Contact your professor.   



          • For other computer access issues, go online to the MSU Information 
Technology  
            Website.  

 
Student Responsibilities 
As a student enrolled in this course, you will be responsible for adhering to and meeting 
posted deadlines and due dates. Posted closing dates along with assignment due dates 
and deadlines found in the Course Calendar within D2L will be strictly enforced. If an 
assignment does not meet the posted deadline, a grade of zero (0) will be recorded for 
that assignment. Extenuating circumstances do occur and will be addressed on an 
individual basis. NOTE: waiting until the last minute to submit an assignment does not 
constitute an extenuating circumstance. 

 
Assignments 
Assignments are a significant portion of the grade and represent the application of the 
material studied. All assignments are to be submitted as instructed in each unit. 
Assignments must be received prior to the deadline. Late assignments are not be 
accepted beyond the deadline. A zero will be recorded for assignments not submitted or 
meeting the final deadline. All assignments must be written at the baccalaureate 
level and will be graded for accuracy, completeness, quality, spelling, grammar, 
punctuation, and integrity.  
  

Independent Reading Assignments 

Unit 1: Chapter 1 

Unit 2: Chapter 2 
Unit 3: Chapter 3 
Unit 4: Chapters 5 & 6 

Unit 5: Chapters 7 & 9 
Unit 6: Chapters 11 & 13 

Final: Review all chapters covered in the course 

  
*Supplemental note outlines and chapter review questions/videos are provided 
within D2L to help guide the reading assignments. 

Discussion Board (45%) 

The discussion board is a mandatory component in this course. All initial posts are due 
by Sunday at midnight the first week the unit is open.  Response posts are due by the 
due date listed for each unit. Assignments are made specifically for this board. Students 
are expected to complete the calculations and write formally (no shorthand or text 
messaging abbreviations) and use APA format and referencing when appropriate. 
Thoughtful responses, constructive critique of fellow students, and meaningful 
participation are expected. Keep in mind the discussion board is a formal assignment 
and part of your final grade. Late discussion board posts are not be accepted 
beyond the deadline. A zero will be recorded for assignments not submitted or 



meeting the final deadline. All assignments must be written at the baccalaureate level 
and will be graded for accuracy, completeness, quality, spelling, grammar, punctuation, 
and integrity. Review the grading rubric for each discussion board assignment.  

Quizzes (30%) 

In each of the units, a quiz will be administered within D2L. These quizzes are open 
book, open notebook, but you will only have one hour to complete them and must be 
prepared as there will not be enough time to research every answer. Quizzes must be 
completed prior to the expiration dates listed in this syllabus. Quiz grades and answers 
will be released after the deadline of each quiz. Specific questions regarding the 
quizzes may be addressed to the instructor. Quizzes will not be made up if missed 
and zero (0) will be recorded. No extra credit activities are available. 

If students have technical difficulties during a quiz, they should use the “Report a 
Problem” link located on the top toolbar within D2L to contact the MSU distance 
education Support Staff and send an email to the course instructor explaining what 
happened.   

Final Exam (25%) 

The final examination is comprehensive and consists of 50 randomized multiple-choice 
questions; with about 5 questions from each chapter. You will have 120 minutes to 
complete the final examination.  You will be required to use LockDown Browser and 
Monitor (Webcam).  Make sure you have the most recent version of the LockDown 
Browser on your computer. You can install the latest version 
here: https://msutexas.edu/distance/lockdown-browser.php. Chromebook Laptops are 
NOT compatible with the LockDown Browser, so you will need to locate a different 
device for the final exam. The Final Examination can be taken any time between the 
exam open dates that are listed in the syllabus. You must complete all module tests 
prior to taking the final examination. You will need to show your ID in Respondus before 
it will allow you to take the exam (so have your photo ID  close).  

10pts will be deducted from your exam grade if you do not do a thorough room 
scan and 5 pts will be deducted for each time you leave the room while testing. A 
thorough room scan includes the area around you and behind the computer. You 
are expected to take this exam alone without anyone in the room.  

  

Tentative Course Schedule 

(All assignments are due at midnight central standard time (CST) 

Date Assignment 

Monday, Jan. 10 Course opens 

Monday, Jan. 17 
Unit 1 Quiz 
Unit 1 Discussion Board 

Monday, Jan. 31 Unit 2 Quiz 

https://msutexas.edu/distance/lockdown-browser.php


Tentative Course Schedule 

(All assignments are due at midnight central standard time (CST) 

Date Assignment 

Unit 2 Discussion Board 

Monday, Feb. 14  
Unit 3 Quiz 

Unit 3 Discussion Board 

Monday, March 7 Unit 4 Quiz 

Monday, March 28 
Unit 5 Quiz 

Unit 5 Discussion Board 

Monday, April 18 
Unit 6 Quiz 

Unit 6 Discussion Board 

March 14-18 Spring Break 

Monday, April 18 Final Exam opens at 8 am 

Sunday, May1 Final Exam closes at midnight 

  

 
Concealed Handgun Carry 
Senate Bill 11 passed by the 84th Texas Legislature allows licensed handgun holders to 
carry concealed handguns on campus, effective August 1, 2016. Areas excluded from 
concealed carry are appropriately marked, in accordance with state law. For more 
information regarding campus carry, please refer to the University’s webpage 
at https://msutexas.edu/campus-carry/index.php . 
  
If you have questions or concerns, please contact MSU Chief of Police Patrick Coggins 
at patrick.coggins@msutexas.edu. 
  

 
Special Needs 
In accordance with Section 504 of the Federal Rehabilitation Act of 1973 and the 
Americans with Disabilities Act of 1990, Midwestern State University endeavors to make 
reasonable adjustments in its policies, practices, services, and facilities to ensure equal 
opportunity for qualified persons with disabilities to participate in all educational 
programs and activities. 
  
The Office of Disability Services (ODS) provides information and assistance, arranges 
accommodations, and serves as a liaison for students, instructors, and staff. The ODS 
has assistive devices such as books on tape, recorders, and adaptive software which 
can be loaned to qualified individuals. A student/employee who seeks accommodations 
on the basis of disability must register with the Office of Disability Services in the 
Counseling Center, Clark Student Center Room 168 (940)397-
4140, https://mwsu.edu/student-life/disability/ . Documentation of disability from a 
competent professional is required. 
  
Individuals with grievances related to discrimination or lack of accommodation on the 
basis of a disability are encouraged to resolve the problem directly with the area 

https://msutexas.edu/campus-carry/index.php
mailto:patrick.coggins@msutexas.edu
https://mwsu.edu/student-life/disability/


involved. If the matter remains unresolved, advice and/or assistance will be provided by 
the Office of Disability Services for resolution. The grievance procedure may be found in 
the Student Handbook and Activities Calendar. The ADA Coordinator may be contacted 
at (940)397-4140, or 3410 Taft Blvd., Clark Student Center Room 168. 
  

 
Honor System 

NURS/RADS/RESP/SOWK 4123 adheres to the MSU Code of Conduct. In particular, 
academic dishonesty, however small, creates a breach in academic integrity. A 
student’s participation in this course comes with the expectation that his or her work will 
be completed in full observance of the MSU Code of Student Conduct. A student should 
consult the current Student Handbook for answers to any questions about the code. 
  
Many components of NURS/RADS/RESP/SOWK 4123 are designed to be highly 
interactive with students helping each other learn. Students are encouraged to take full 
advantage of many resources available including online D2L course resources, Internet 
sites, other textbooks and journals, faculty, and peers when answering objectives. This 
interactive collegial learning environment is conducive to lifelong learning. 
  
Specific components of NURS/RADS/RESP/SOWK 4123 are designed to represent the 
efforts of each student individually and are not to be shared or copied (plagiarized) from 
other sources. These components include the discussion board, group activities, 
module quizzes, and the comprehensive final exam. When students submit their efforts 
for grading, they are attesting they abided by this rule. 
Cheating includes, but is not limited to: (1) use of any unauthorized assistance in taking 
quizzes, tests, or examinations; (2) dependence upon the aid of sources beyond those 
authorized by the instructor in writing papers, preparing reports, solving problems, or 
completing other assignments; or (3) the acquisition of tests or other academic 
materials belonging to the university faculty or staff without permission. 

Plagiarism includes, but is not limited to: the use of, by paraphrase or direct quotation 
without correct citation in the text and on the reference list, the published or unpublished 
works of another person. Students may not submit papers and assignments that they 
have previously submitted for this or other courses. The use of materials generated by 
agencies engaged in "selling" term papers is also plagiarism. Students are encouraged 
to review the tutorials and suggested websites for more information about 
plagiarism. Papers and other assignments may be submitted to an external agency for 
verification of originality and authenticity. 
Academic dishonesty (cheating, plagiarism, etc.) will not be tolerated in this 
class. Whenever a student is unsure of whether a particular situation will be interpreted 
as academic dishonesty, the student should ask the instructor for 
clarification. If students are guilty of academic dishonesty, a grade of zero (0) may be 
given for the quiz, assignment, etc. Cases may also be referred to the Dean of Students 
for possible dismissal from the university. 

Note: By enrolling in this course, the student expressly grants MSU a “limited right” in 
all intellectual property created by the student for the purpose of this course. The 



“limited right” shall include, but not limited to: the right to reproduce the student’s work 
product in order to verify originality and authenticity as well as for educational purposes. 
Specifically, faculty may submit student papers and assignments to an external agency 
to verify originality and authenticity to detect plagiarism. 
  

 
Administrative Process 

Unresolved issues related to this course should be first addressed between the student 
and the course instructor. If there is no resolution, students must follow this sequence: 

1. Director of Interdisciplinary Studies 

a. Dr. Randy Case (940) 397-4652 

2. Department Chair 

a. BSRS, Dr. Beth Vealé (940) 397.4611 

b. BSRC, Dr. Jennifer Anderson (940) 397.4656 

c. BSN, Dr. Robin Lockhart (940) 397-4614 

d. BSW, Dr. Satya N. Ayinagadda (940) 397-4438 

3. College Dean, Dr. Jeff Killion (940) 397.4594 

4. Dean of Students, Matthew Park (940) 397.6273 

  

 

tel:19403974614

